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ABOUT CHRONOSEDIT

ChronosEdit is a software tool that allows teachers without any computing knowledge 
to easily edit a database (archive) on a chosen historical period, which students can 
then view using Chronos.

An archive generally contains the following:

- An introduction page including a timeline of historical periods under study 
(Antiquity, Middle Ages, Modern Era; 15th, 16th, 17th, 18th, 19th, 20th centuries; 
Bronze Age, Iron Age; Hunter-Gatherers, Agriculturalists, Pastoral Nomads, 
Metallurgists, etc.)

- Introductory notes which, for each defined theme (Arts, Commerce, Habitat, 
Religion, Political Rivalries, Science, etc.), identify highlights and major trends 
associated with the historical periods under study

- Five types of cards (Document Cards, Chronology Cards, Image Cards, Audiovisual 
Cards, Multimedia Cards)

- A glossary

- Links between cards, forming a closely woven logical network

Once you have created an archive in ChronosEdit, students may open it using Chronos 
software. Since Chronos behaves as a viewer for the archive, students will be able to 
access, but not edit the content (introduction page, notes, cards, links, etc.). Rather, 
Chronos possesses unique capabilities that allow students to search for and select 
cards of interest, which they will use to develop a slideshow.
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START

The ChronosEdit start window prompts you to open an archive file or create a new 
one. Enter your name in the User field to ensure that when you create new content, it 
will contain this default signature.

If you opt to create a new archive, you will be prompted to name a folder (My-Archive, 
for example) and save it to your hard drive. This folder contains an empty archive 
(file extension .arch with an icon resembling a filing cabinet) and a MEDIAS folder, 
which will automatically save the media used in your cards (images, audio, video, etc.).
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*Note: The archive file (.arch) should always be kept together with the MEDIAS folder.

ChronosEdit opens the introduction page, which is blank when you first create an 
archive. If you open an existing archive, the introduction page will include whatever 
information you saved during your last work session. 
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The Help Guide describes specific functionalities of ChronosEdit software in detail, but 
the following is an overview of what is generally available, regardless of where you are 
in the application:

- Main menu bar at the top of your screen

- Header, including the software name, Page menu, archive title and file name. 
*Note: The Page menu here is exactly the same as the Page menu in the main 
menu bar, except that it appears horizontally for easier access to the three 
sections of the software

- Search field at the top of the page, available for all sections except the 
introduction page

- Tabs to access the subsections for each page

For more information about the functionalities of each page and subsection (tabs), 
consult the detailed explanations for each in the Help Guide.
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MENU BAR

The main menu bar, at the top of your screen, contains five menus:

File Menu

Edit Menu

Page Menu

Window Menu

Help Menu

File Menu

In addition to basic file management commands found in other applications, the File 
menu includes a Check the archive command, which is unique to ChronosEdit.

New

The New  command creates a new archive file with an icon resembling a filing cabinet 
(file extension .arch). In this new archive, you will define historical periods for study, 
choose themes to present the periods, write introductory notes, compose cards, 
construct timelines, build a glossary, and add links. When you select New, a dialogue 
box prompts you to enter the name of your new archive (a maximum of 26 
characters) and specify where to save the archive. The directory that is then created 
contains the empty archive (file extension .arch) and a MEDIAS folder, which will 
automatically save the media used in your cards (images, audio, video, etc.).
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*Note: The archive file (.arch) should always be kept together with the MEDIAS folder.

Open…

The Open… command allows you to open an archive saved during a previous work 
session. A standard dialogue box prompts you to search your computer and open an 
archive file with an icon resembling a filing cabinet (file extension .arch).

You can open more than one archive at a time and navigate between them by clicking 
on their respective windows, or by selecting one in the Window menu. Main menu 
commands may be applied to the active archive only, which is the one in the 
foreground.

Close

The Close command closes the active archive (the window in the foreground if more 
than one archive is open). Before closing, a dialogue box prompts you to save the 
changes to your archive.

Save

The Save command saves the changes made to the active archive (the window in the 
foreground if more than one archive is open). The name of an archive can contain a 
maximum of 26 characters followed by the file extension .arch (My-Archive.arch, for 
example).
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Save as…

The Save as… command saves the active archive (the window in the foreground if 
more than one archive is open) under another name. The name of an archive can 
contain a maximum of 26 characters followed by the file extension .arch 
(My-Archive2.arch, for example).

Page Setup

The Page Setup command opens your printer's dialogue box, in which you can define 
the paper size, scale (%), and document orientation (portrait or landscape).

Export in Text format

The Export in Text format command allows you to save the archive content in a plain 
text file, which can be opened in most word processing applications. Note that plain 
text does not contain any formatting (bold, italics, underline, etc.). Expressions that 
include formatting in the cards will be displayed using HTML tags.

Check the archive

When you have completed your work, the Check the archive command allows you to 
verify the content of your archive by providing a list of cards, notes and links that 
are missing data. Check the boxes of all the items you wish to verify.
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When you click on OK, the archive is verified and a text file with the name of the 
archive plus the file extension .txt is created on your desktop (My-Archive.txt, for 
example). This file contains a list of all incomplete items among those you chose to 
verify. The file may be opened using any word processing software.

Quit

The Quit command allows you to exit ChronosEdit. Before closing, a dialogue box 
prompts you to save the changes made to your archive(s).

Edit Menu

In addition to basic editing commands found in other applications, the Edit menu 
includes the Create a glossary link, Create a card link and Create a web link 
commands, which are unique to ChronosEdit. These commands are only available under 
certain conditions: when the cursor is within an editable text box, when a portion of 
the text is selected, when formatting can be applied to the text, when rows in certain 
tables are selected, or when items in a Multimedia Card are selected. The following 
sections explain when to use each command..
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Undo

The Undo command is only available when the cursor is within an editable text box. It 
allows you to undo the last operation made in that area, such as a text insertion, cut, 
paste, etc.

*Note: You cannot Undo the deletion of table rows and items in Multimedia Cards.

Redo

The Redo command is only available when the cursor is within an editable text box. It 
allows you to redo the last operation made in that area, such as a text insertion, cut, 
paste, etc.

Cut

The Cut command is only available when a portion of editable text is selected, when at 
least one row of a card or link table is selected, or when at least one item (image, 
media, chronology chart, historical document, or text box) is selected in a Multimedia 
Card. This command deletes selected text or items.

*Note: Once the Cut command is applied to table rows and items in Multimedia Cards, 
it cannot be undone. 

Copy

The Copy command is only available when a portion of editable text is selected, when 
at least one row of a card or link table is selected, or when at least one item (image, 
media, chronology chart, historical document, or text box) is selected in a Multimedia 
Card. This command copies selected text or items for future use (see the Paste 
command).

Paste

The Paste command allows you to retrieve text or items previously stored with the 
Cut or Copy command, and insert them into text boxes, card and link tables, or 
Multimedia Cards (see the Cut and Copy commands). You must first click within the 
area where you wish to paste the text or item, and then use the Paste command.

- 1 0 -



 (17/06/09 10:38)

Select All

The Select All command allows you to select all the content in text boxes, card and 
link tables, or Multimedia Cards. You must first click within the area containing the 
content you wish to select, and then use the Select All command.

Find

The Find command is available for text when the window of an introductory note, card 
or glossary definition is in the foreground. You must first click within the text box 
containing the content you wish to search, and then use the Find command to open a 
dialogue box.

To search for a term, enter it in the text field, and use the arrows on the left to 
move to the next or previous match. The OK button closes the Find dialogue box.

Plain

The Plain command, available in editable text boxes, removes formatting from the 
selected text.

Bold

The Bold command, available in editable text boxes, applies bold formatting to the 
selected text.

Italic

The Italic command, available in editable text boxes, applies italics to the selected 
text.
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Superscript

The Superscript command, available in editable text boxes, applies superscript 
formatting to the selected text.

Subscript

The Subscript command, available in editable text boxes, applies subscript formatting 
to the selected text.

9 (to 24) point

The 9 point to 24 point commands, available in editable text boxes, apply the chosen 
font size to the selected text.

Create a glossary link

The Create a glossary link command, available when a term is selected in an editable 
text box, allows you to create a new glossary link without having to go to the Links 
page. The command initially prompts you to confirm that you would like to create a 
new glossary link. Click on OK to open the Edit the glossary link dialogue box, and enter 
the variants and definition of the glossary term.

For more information, consult the Glossary links tab section of the Help Guide.

Create a card link

The Create a card link command, available when a term is selected in an editable text 
box, allows you to create a new card link without having to go to the Links page. The 
command initially prompts you to confirm that you would like to create a new card 
link. Click on OK to open the Edit the card link dialogue box, and associate the term 
with a specific card.

For more information, consult the Card links tab section of the Help Guide.

Create a web link

The Create a web link command, available when a term is selected in an editable text 
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box, allows you to link the term to a URL address. The command opens the Edit the 
web link dialogue box with the selected term in the upper field. Enter the desired URL 
address in the lower field.

When you click on OK, the term appears throughout the archive as an underlined link. 
Clicking on the term opens your web browser to the specified web page. To delete the 
link, carefully select the term, and click on the Create a web link command. Remove 
the URL address previously entered in the dialogue box.

*Note: Clicking on the link instead of selecting it will open the web page, not the link 
dialogue box.

Page Menu

The Page menu includes three commands: Introduction, Cards and Links, which allow 
you to open the various sections of the application to develop archive content.

For more information, consult the INTRODUCTION PAGE, CARDS PAGE and LINKS 
PAGE sections of the Help Guide.

Window Menu

The Window menu displays a list of all currently open windows. You can open more than 
one archive at a time, and navigate between them by clicking on the corresponding 
window or selecting it in the Window menu.
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A check mark next to the name of a window in this menu indicates that the archive 
has been modified since it was last opened or saved.

Help Menu 

The Help menu includes three commands: ChronosEdit Help, Credits and Comments.

The ChronosEdit Help command opens a window that provides information on the 
various functions of ChronosEdit. You can print the text by clicking on the printer icon 
in the lower right corner of the window.
 
The Credits command provides a list of organizations involved in the production of 
ChronosEdit and individuals who contributed to its development.
 
The Comments command opens a dialogue box that links to the CCDMD website, where 
you can provide comments and evaluate the quality of the ChronosEdit application.
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INTRODUCTION PAGE

On the introduction page, you can:

- Define the historical periods that your archive will cover, for example: Antiquity, 
Middle Ages, Modern Era; 15th, 16th, 17th, 18th, 19th, 20th centuries; Bronze Age, 
Iron Age; Hunter-Gatherers, Agriculturalists, Pastoral Nomads, Metallurgists, etc.)

- Specify the themes for each period (Arts, Commerce, Habitat, Religion, Political 
Rivalries, Science, etc.)

- Add data to the timeline

- Write introductory notes for each period and theme

Chronos, the student application, will display all the introductory material as you 
entered it in ChronosEdit, but will not allow any changes to be made.  
  
Two separate subsections may be accessed via tabs on the introduction page: 
Introduction and Introductory Notes. 

For more information, consult the Introduction tab and Introductory notes tab 
sections of the Help Guide.
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INTRODUCTION TAB

Clicking on the Introduction tab opens a page that is virtually empty when you first 
create an archive. As you develop content, various items fill up this page, which 
constitutes the introduction to your archive. The presentation of the content here is 
identical when students view it using Chronos. It can include the following:

- The archive title

- A subtitle and/or your signature

- A timeline (that evolves as you add cards to the archive)

- Drop-down lists for each period, containing the themes you have defined, and for 
which you have written introductory notes

- Decorative media, such as image, audio or video files.
*Note: You must first create image and media cards before adding them as 
decorative media

- A brief introduction text presenting the archive, software and/or yourself
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Clicking on the + button on the bar below the Introduction tab displays a drop-down 
menu with two options: Edit the content of the Introduction and Edit Periods and 
Themes.

Edit the Content of the Introduction

The Edit the content of the Introduction command opens an edit box where you can 
enter the title and subtitle of your archive, choose decorative media (from previously 
created image or media cards), and write the introduction text.

When you click on Apply or OK, the information you entered is displayed on the 
introduction page.

*Note: The introduction text can be written collaboratively by checking the box next 
to Collaboration tools. The collaborative mode is especially useful when working as a 
team to develop an archive. For more information, consult the COLLABORATION 
TOOLS section of the Help Guide. 

- 1 7 -



 (17/06/09 10:38)

Edit Periods and Themes

The Edit Periods and Themes command opens an edit box where you can define 
periods, themes and the general timeline for your archive.

- Clicking on the + button to the right of the word “PERIODS” allows you to add 
periods to the associated table. Clicking on the - button deletes selected periods. 
For each period, enter a title, start date and end date. The list of periods should 
be in ascending chronological order and dates should not overlap. An asterisk can 
be entered in the “End Date” field of the last period to indicate that this period is 
ongoing. When necessary, an asterisk can also be entered in the "Start Date" field 
of the first period.

- Clicking on the + button to the right of the word “THEMES” allows you to add 
themes to the associated table. Clicking on the - button deletes selected themes. 
For each theme, enter a title and a brief definition that will appear in the 
introductory note for this theme.

- If you wish, you can define five eras with their start and end dates (an asterisk 
can be entered in the last "End Date" field to indicate that this era is ongoing).. 
These should be broader periods than those covered in the archive to situate 
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events in the context of a longer time frame. The list of eras should be in 
ascending chronological order and dates should not overlap (for example, 
Prehistory, Antiquity, Middle Ages, Modern Era, Present). If you decide to add 
eras, a second line in pastel colours denoting these eras will enrich the 
introduction timeline. Move the cursor over the various eras to appreciate the 
dynamic qualities of the timeline. Clicking on the timeline provides a very different 
view of the eras defined in your archive.

*Note: It is important to define archive periods and themes before creating cards, 
since you will want to link the cards to specific periods and themes. Furthermore, 
deleting periods and themes while creating the archive may result in broken links.

INTRODUCTORY NOTES TAB

Introductory notes are brief texts introducing a specific historical period and related 
theme. They may also include decorative media and a list of links to relevant cards.
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Once you have defined the periods and themes for the archive, clicking on the 
Introductory Note tab displays a list of all the possible combinations of these periods 
and themes. For example, if you defined three periods (15th, 16th, 17th centuries) and 
two themes (Arts and Religion), the list would display six possible combinations: 15th 
century - Arts, 15th century - Religion, 16th century - Arts, 16th century - Religion, 
17th century - Arts, 17th century - Religion. You can write an introductory note for 
each of these combinations.
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Double-clicking on a row in the table of Introductory Notes combinations opens an 
empty note.
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It is not necessary to close one introductory note in order to access another one. You 
can click on the two drop-down lists at the bottom of the window to navigate between 
periods and themes. The drop-down list on the left displays available periods, and the 
one on the right displays available themes. In the lower right corner of the window, 
there are three icons from left to right: an edit button (icon resembling a text editing 
cursor and the letter 'e'), which opens the edit window, a print button (icon resembling 
a printer), which prints the note, and a history button (icon with three horizontal 
lines), which displays your navigation history.

In the edit window, you can:

- Enter the note title

- Compose the note itself

- Choose decorative media, such as image, audio or video files
*Note: You must first create image and media cards before adding them as 
decorative media.

- Drag relevant cards into the For more information area of the edit window (they 
will appear as links in the note)

- 2 2 -



 (17/06/09 10:38)

*Note: Introductory Notes can be written collaboratively by checking the box next to 
Collaboration tools. The collaborative mode is especially useful when working as a 
team to develop an archive. For more information, consult the COLLABORATION 
TOOLS section of the Help Guide.

In both ChronosEdit and Chronos, you can open notes using the drop-down menus for 
each period appearing on the Introduction page timeline.
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CARDS PAGE

On the Cards page, you can locate and edit the cards in the archive. There are five 
types of cards: Document Cards, Chronology Cards, Image Cards, Audiovisual Cards, 
and Multimedia Cards. Each is associated with a tab on the Cards page. 

For more information on types of cards, consult the CARDS PAGE subsections of 
the Help Guide.

Despite their differences, all of the cards and tabs have some characteristics in 
common.

Content of the Cards Page

Shared Characteristics of Cards

Editing the Fields Common to all Types of Cards

Content of the Cards Page

All of the tabs on the Cards page include the following:

- Search by keyword, period, date, or theme. For more information, consult the 
SEARCH TOOLS section of the Help Guide.

- Five tabs, one for each type of card

- Feedback on the number of cards in the active tab resulting from a search with 
given criteria

- A + button to add the type of cards specific to the active tab

- A - button to delete the selected card(s)

- A print button (icon resembling a printer) to print the selected card(s) 

- The list of cards you have created in the active tab
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Each row of the card table is associated with a specific card, while each column is a 
subset of card data: card code (automatically generated by the application), title, 
start date, end date, type, status, date of creation, and date of modification). 
Clicking on the title of each column will sort the entries in either ascending or 
descending order, with the exception of the Type column. Clicking on the title of the 
Type column displays a drop-down list of all the card subtypes you have created to 
more accurately classify your cards. You can select a subtype from this list to refine 
your search to a specific type of card.

To view a card, double-click in the corresponding row on the Cards page.
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Shared Characteristics of Cards

Despite their differences, all of the cards have some characteristics in common.

- Dark orange header indicating card type and subtype, where applicable, card code, 
and author(s) signature(s)

- Close button (X) in the upper right corner

- Title and subtitle 

- Descriptive text, generally located on the right, with the exception of Multimedia 
Cards, where it is located on the left 

- Interactive timeline that situates the events described on a specific card within 
the general timeline of the entire archive. The line varies from card to card — 
move the cursor over it to discover its dynamic qualities 

- Edit button (icon resembling a text editing cursor and the letter 'e'), which opens 
the edit window of the card
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- Print button (icon resembling a printer), which prints the card

- History button (icon with three horizontal lines), which displays your navigation 
history

- Button with an icon resembling a flip chart (Previous Card and Next Card) to 
navigate quickly between cards without closing the window or returning to the 
card list

Editing the Fields Common to all Types of Cards

When you click on the + button on the Cards page and select New card, or when you 
click on the edit button (icon resembling a text editing cursor and the letter 'e') in the 
lower portion of an existing card, an edit window opens.

This window allows you to edit the fields that are common to all types of cards. For 
information on editing items specific to each type of card, consult the corresponding 
tab section of the Help Guide.
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Title

Enter the title in the text box

Subtitle

Enter the subtitle in the text box

Subtype 

The subtype classifies cards to facilitate search functions. ChronosEdit provides 
default subtypes for each type of card. Click on the arrow at the right of the text box 
to select a subtype from the drop-down list. To add a new subtype to the list, enter it 
in the Edit card subtypes field, and click on the + button. To delete a subtype, select 
it in the drop-down list, and click on the - button.

Description

This description will appear on the right side of the card, except for Multimedia Cards, 
where it is on the left. Enter text in the text box, and then use the Edit menu 
commands to modify the text formatting (see Edit Menu in the MENU BAR section 
of the Help Guide). 
 
*Note: The description can be written collaboratively by checking the box next to 
Collaboration tools. The collaborative mode is especially useful when working as a 
team to develop an archive. For more information, consult the COLLABORATION 
TOOLS section of the Help Guide. 

Start and End dates

Enter the start and end dates associated with the events described in the card.

*Note: For a time-specific event, you must enter the same date in both the Start and 
End fields, otherwise the event will be recorded in the archive as ongoing.

Data for Chronology chart?

Check this box to indicate that the card can be used by students to create a 
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chronology chart. Enter a significant title that will identify the card in the chronology 
chart. You may also enter a relevant sub-period; for example, the title of the period 
for Louis XI could be Life under Louis XI (1423-1483), while the title of the sub-period 
might be King of France (1461-1483). In the chronology chart, the line corresponding 
to this sub-period will appear in a different colour, below the period line. For more 
information, consult the CHRONOLOGY tab section of the Help Guide.

Associated Period(s)

Select the period(s) to which the card corresponds.

Associated Theme(s)

Select the theme(s) to which the card corresponds.

Associated Keywords

Select the keywords to which the card corresponds. To add a keyword to the list, 
enter it in the Edit keywords field, and click on the + button. To delete a keyword, 
select it in the drop-down list, and click on the - button. 

Status

The Status field indicates the current state of the card (for example, “Review,” 
“Copyright needed,” “Unfinished,” etc.). It is an organizational tool to facilitate your 
own work or collaboration with team members. Click on the arrow at the right of the 
text box to select a status type from the drop-down list. To add a status type to the 
list, enter it in the Edit status field, and click on the + button. To delete a status 
type, select it in the drop-down list, and click on the - button. 

Invisible?

Check this box to make the card invisible to students in Chronos. An invisible card can 
be included in a Multimedia Card or timeline, but Chronos search tools will not retrieve 
it. This is useful when you want to add images, documents or media to a Multimedia 
Card without having to write descriptive texts for these items. 
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Memo

The Memo field is a text field. You can use it to write notes, comments, messages, 
etc. 

Signature

The Signature field allows you to sign your cards. Click on the arrow at the right of 
the text box to select a signature from the drop-down list. To add a signature to the 
list, enter it in the Edit signature field, and click on the + button. To delete a 
signature, select it in the drop-down list, and click on the - button.
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DOCUMENT TAB

On the Cards page, clicking on the DOCUMENT tab displays a list of all the Document 
Cards created in the archive. You may add or delete cards in this section of the 
application. The main component of a Document Card is the area resembling a piece of 
parchment, located to the left of the card's descriptive text. The parchment contains 
a historical document, such as a letter, poem, personal account, sermon, law, treaty, 
etc.). The text on the right should describe this document. 
 
After editing the fields common to all cards (see the CARDS PAGE section of the 
Help Guide), enter the text of the historical document, and a reference, if you wish.

Entering Text of a Historical Document

Enter the text of the historical document directly in the area resembling a piece of 
parchment. The default font is italic and cannot be modified. You may capitalize the 
title of the document to distinguish it from the text itself. When the cursor is inside 
the text of the document, the Edit menu provides basic word processing functions.
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Entering a Reference for a Historical Document

Enter the reference for the historical document in the text box below the piece of 
parchment. The box will  automatically expand to accommodate the length of your 
text. When the cursor is inside this text box, the Edit menu provides formatting 
options in addition to basic word processing functions. However, the font size may not 
be modified. When viewed in Chronos, the reference will appear in the same position 
but without the borders.

- 3 2 -



 (17/06/09 10:38)

CHRONOLOGY TAB

On the Cards page, clicking on the CHRONOLOGY tab displays a list of all the 
Chronology Cards created in the archive. You may add or delete cards in this section 
of the application. The main component of a Chronology Card is a chronology chart of 
parallel events and historical facts, located to the left of the card's descriptive text. 
The text on the right should elaborate on the events included in the chronology chart. 
 
After editing the fields common to all cards (see the CARDS PAGE section of the 
Help Guide), you may now build a chronology chart.

Building a Chronology Chart

Double-click on the rectangle located on the left side of the card to open the 
chronology chart edit window.
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The lower table in this window contains all the archive cards for which you checked 
Data for Chronology chart? (See Editing the Fields Common to All Types of 
Cards in the CARDS PAGE section of the Help Guide). 

You can use the search tool or sort table columns by clicking on the column header to 
find cards you wish to include in the chronology chart. You can also select a card and 
access an overview of its content by clicking on the small dark triangle located in the 
lower left corner of the window.
 
To add cards to the chronology chart, drag selected rows from the lower table in the 
edit window to the upper window (Cards associated with the chronology chart). Sort 
these cards by dragging them into chronological order.
 
Clicking on Apply or OK will record the individual timelines in the chronology chart. Each 
card associated with the chronology chart will be displayed in the following format: 
black period title, orange period subtitle, associated timeline(s), start date, and end 
date.
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IMAGE TAB

On the Cards page, clicking on the IMAGE tab displays a list of all the Image Cards in 
the archive. You may add or delete cards in this section of the application. The main 
component of an Image Card is an image, located to the left of the card's descriptive 
text. The image may be a historical map, work of art, picture of an artifact, portrait, 
etc. The text on the right should describe the image. 

After editing the fields common to all cards (see the CARDS PAGE section of the 
Help Guide), add the image, and a reference, if you wish.

Adding an Image

Double-click on the rectangle located on the left side of the card (or on the image 
itself if you wish to change a pre-existing image). A standard window allows you to 
browse your computer and peripherals for an image (accepted formats: BMP, JPEG or 
PICT). When you choose an image, ChronosEdit creates a JPEG copy in the MEDIAS/IMG 
directory of the archive.
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*Note: The image will automatically resize to fit the space available on the card, but in 
Chronos, students will be able to click on the image and enlarge it.

Entering a Reference for an Image

Enter the reference for the image in the text box below the image. The box will 
automatically expand to accommodate the length of your text. When the cursor is 
inside this text box, the Edit menu provides formatting options in addition to basic 
word processing functions. However, the font size may not be modified. When viewed 
in Chronos, the reference will appear in the same position but without the borders.
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AUDIOVISUAL TAB

On the Cards page, clicking on the AUDIOVISUAL tab displays a list of all the 
Audiovisual Cards created in the archive. You may add or delete cards in this section 
of the application.

The main component of an Audiovisual Card is a Play media button, located to the left 
of the card's descriptive text. Clicking on the Play media button plays an audio or 
video file, such as a piece of music, narration of a personal account or poem, video, 
etc. The text on the right should describe the media. 
 
After editing the fields common to all cards (see the CARDS PAGE section of the 
Help Guide), add the media, and a reference, if you wish. 

Adding Media

Double-click on the media selection tool labelled Choose media (icon resembling a movie 
clapboard) located on the left side of the card. A standard window allows you to 
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browse your computer and peripherals for media (accepted formats: AIFF, AVI, MIDI, 
MOV, MPEG, MP3, MP4, QT, WAVE). When you choose a media file, ChronosEdit creates 
a copy in the MEDIAS/QT directory of the archive, and the media selection tool 
becomes a Play media button.

Entering a Media Reference

Enter the reference in the text box below the media. The text box will automatically 
expand to accommodate the length of your text. When the cursor is inside this text 
box, the Edit menu provides formatting options in addition to basic word processing 
functions. However, the font size may not be modified. When viewed in Chronos, the 
reference will appear in the same position but without the borders. 
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MULTIMEDIA TAB

On the Cards page, clicking on the MULTIMEDIA tab displays a list of all the Multimedia 
Cards created in the archive. You may add or delete cards in this section of the 
application. The main component of a Multimedia Card is the descriptive text, which 
differs from other card types in that it is located on the left. The rest of the card is 
initially empty. You can adjust the size of the text box to fit the entire card or leave 
room for any number of other items, such as images, media, historical documents, 
chronology charts and timelines, or additional text boxes. You can add these items by 
using the floating toolbar provided for this purpose. Multimedia Cards allow for an 
intensive analysis of a specific subject, such as the biography of a historical figure, 
the description of an event, or the development of a specific topic.

 
After editing the fields common to all cards (see the CARDS PAGE section of the 
Help Guide), you can change the size of the text box, and add items using the toolbar.

Changing the Size of the Card’s Descriptive Text
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To change the size of the card’s descriptive text, mouse over the lower horizontal 
border, the vertical border on the right, or the lower right corner. Arrows indicate in 
which direction to move. Click and hold down the mouse button to change the size of 
the text box. 

Adding Items to a Multimedia Card

In ChronosEdit, a Multimedia Card always includes a floating toolbar. It is displayed in 
the foreground of your screen and can be moved around at your convenience.

The five toolbar buttons are used to add items (image, media, document, chronology 
chart, or text box) to a Multimedia Card. Select the desired type of item by grabbing 
the associated button on the toolbar and dragging it onto the card. An empty object 
associated with that particular type of item opens in the card.

*Note: Avoid the top (title) and bottom (timeline and buttons) areas of the card when 
adding items.
 
Double-clicking on the empty object opens an edit window that allows you to select or 
search for cards to add, or create a new card.

*Note: The text box does not require an edit window; simply double-click on the word 
Text to replace it with your own content.

To add an item, you must select cards that match the toolbar button you selected 
(Media button = Media Card; Document button = Document Card, etc.) Only the card 
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types associated with the specific button will display in the edit window table. You can 
use the search tool or sort table columns by clicking on the column header to find 
cards you wish to include in the Multimedia Card. You can also select a card and 
access an overview of its content by clicking on the small dark triangle located in the 
lower left corner of the window.
 
Clicking on Apply or OK will add the item to the Multimedia Card. 

Functions that Apply to Items of a Multimedia Card

Certain operations can be applied to items (image, media, document, chronology chart, 
or text box) selected in a Multimedia Card:

- Click on an item to select it. When an item is selected, it displays red handles 
along its edges.

- Select multiple items by:
> Clicking on each item while holding down the Shift key
> Clicking on the card background, holding down the mouse button and dragging 
the cursor over each item
> Using the Select All command in the Edit menu

- Move selected items by:
> Clicking on one of the selected items to drag the group of items to a different 
position
> Using the arrow keys on your keyboard to move the group one pixel at a time in 
any direction
> Using a combination of the arrow keys and Shift key to move the group 10 
pixels at a time in any direction

- Change the size of a selected item by dragging the red handles around its edges
*Note: The Play media button cannot be resized.

- Cut selected items by:
> Pressing the Delete key 
> Using the Cut command in the Edit menu

- Duplicate selected items by using the Paste command in the Edit menu
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LINKS PAGE

On the LINKS page, you can create links to make cards more interactive in Chronos. 
You may add or delete links in this section of the application. There are two types of 
links: glossary links (terms in red open a window containing the definition of the term), 
and card links (terms in green open the card associated with the term). For more 
information, consult the Glossary links tab and Card links tab sections of the 
Help Guide. 
 
Despite their differences, the two link tabs have some characteristics in common.

- Search by keyword. For more information, consult the SEARCH TOOLS section 
of the Help Guide.

- Two tabs, one for each type of link

- Feedback on the number of links in the active tab resulting from a search with 
given criteria 

- A + button to add the type of links specific to the active tab

- A - button to delete the selected link(s)

- A print button (icon resembling a printer) to print the selected link(s) 

- The list of links created in the active tab
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Each row of the link list is associated with a specific link, while each column is a 
subset of link data: link code (automatically generated by the application), term, 
variants, definition, status, date of creation, and date of modification). Clicking on the 
title of each column will sort the entries in either ascending or descending order.
 
To view a glossary link, double-click in the corresponding row of the Glossary links tab 
section of the LINKS PAGE. To edit this link, click on the Edit button in the lower right 
corner of the window (icon resembling a text editing cursor and the letter 'e') to open 
the edit window.
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To open a card link's edit window, simply double-click in the corresponding row of the 
Card links tab section of the LINKS PAGE.

For more information about edit windows, consult the Glossary Links Tab and Card 
Links Tab sections of the Help Guide. 
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GLOSSARY LINKS TAB

On the LINKS page, clicking on the Glossary links tab displays a list of all glossary links 
created in the archive. You may add or delete links in this section of the application.

When you create a glossary link, the term (and its variants) are automatically 
displayed as red links in all the cards and introductory notes where the term (and its 
variants) appear. Clicking on a red link opens a window containing the term's definition.
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Click on the Edit button in the lower right corner of the window (icon resembling a text 
editing cursor and the letter 'e') to open the edit window. To add a new link, click on 
the + button in the Glossary links tab.

Enter information in the following fields:
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T e r m

Enter the term to be defined.

Va r i an ts

Enter the potential variants of the term, separated by commas (plural, conjugated 
forms, synonyms, etc.).

Def in it ion

Enter the definition of the term in the text box, and then use the Edit menu 
commands to modify the text formatting (see Edit Menu in the MENU BAR section 
of the Help Guide). 

*Note: The definition can be written collaboratively by checking the box next to 
Collaboration tools. The collaborative mode is especially useful when working as a 
team to develop an archive. For more information, consult the COLLABORATION 
TOOLS section of the Help Guide. 

S t a tu s

The Status field indicates the current state of the link (for example, “Review,” 
“Copyright needed,” “Unfinished,” etc.). It is an organizational tool to facilitate your 
own work or collaboration with team members. Click on the arrow at the right of the 
text box to select a status type from the drop-down list. To add a status type to the 
list, enter it in the Edit status field, and click on the + button. To delete a status 
type, select it in the drop-down list, and click on the - button. 

Memo
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The Memo field is a text field. You can use it to write notes, comments, messages, 
etc.
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CARD LINKS TAB

On the LINKS page, clicking on the Card links tab displays a list of all card links created 
in the archive. You may add or delete links in this section of the application.

When you create a card link, the term (and its variants) are automatically displayed 
as green links in all the cards and introductory notes where the term (and its 
variants) appear. Clicking on a green link opens the card associated with the term.
 
To add a new link, click on the + button in the Card links tab.
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Enter information in the following fields:

T e r m

Enter the term.

Var i an ts

Enter the potential variants of the term, separated by commas (plural, conjugated 
forms, synonyms, etc.).

Associated Card
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Select a card in the table. You can use the search tool or sort table columns by 
clicking on the header to find cards you wish to associate with the link. You can also 
access an overview of its content by clicking on the small dark triangle located in the 
lower left corner of the window.

S ta tus

The Status field indicates the current state of the link (for example, “Review,” 
“Copyright needed,” “Unfinished,” etc.). It is an organizational tool to facilitate your 
own work or collaboration with team members. Click on the arrow at the right of the 
text box to select a status type from the drop-down list. To add a status type to the 
list, enter it in the Edit status field, and click on the + button. To delete a status 
type, select it in the drop-down list, and click on the - button.

Memo

The Memo field is a text field. You can use it to write notes, comments, messages, 
etc.
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COLLABORATION TOOLS

Developing an archive can be very time-consuming. ChronosEdit therefore provides 
tools for authors to work together: tracking text changes, importing cards from one 
archive to another, Creation and Modification columns in the various tables listing 
items in the archive, and specific fields that promote collaboration, such as Status 
and Memo.

Tracking Text Changes

Text such as card descriptions, introductory notes and glossary link definitions can be 
written collaboratively by checking the box next to Collaboration tools. The text area 
of the edit window will adopt a split-screen mode displaying two versions of the work: 
the current version (in progress) and the last approved version. A magnifying glass 
option allows you to enlarge the workspace. 

Text added to the working version displays in blue, while deleted text is crossed out 
(strikethrough). When you click on OK to close the edit window, changes are not visible 
in cards, notes or definitions. In the Cards page table, the second column 
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corresponding to a modified item displays a dash, indicating that the text has been 
changed but not yet approved.
 
When you decide that the working version is final, click on the check mark above the 
workspace to accept the changes (blue and crossed out text). The new text will then 
appear in the Last approved version space, as well as in the card, note and glossary 
definition. In the Cards page table, the second column corresponding to a modified 
item now displays a check mark, indicating that the last version of the text has been 
approved. 

This feature allows collaborators to sort and quickly locate all items requiring 
approval.

Importing Cards from one Archive to Another

Once archive periods and themes have been defined, authors can duplicate the archive 
directory so that they can each add their own cards and links. Once this is done, both 
archives can be opened to copy and paste cards and links from one to the other.

*Note: Introductory notes cannot be imported in this way.
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Creation and Modification Columns

The tables listing cards, notes and links share two columns in common, one indicating 
the creation date of an item, the other indicating the modification date. Referring to 
these columns, collaborators can sort and quickly locate all recently added items, for 
example.

Status and Memo Fields

The edit windows for cards, notes and links include specific fields that promote 
collaboration: The status field indicates the current state of an item (for example, 
“Review,” “Copyright needed,” “Unfinished,” etc.). The Memo field is a text field. You 
can use it to write notes, comments, messages, questions, etc. to collaborators.
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SEARCH TOOLS

Large amounts of content will be stored in an archive over time. Sorting information 
by column is a useful method for finding specific cards, notes and links, but it is not 
sufficient. The search boxes above the Introductory Note, Document, Chronology, 
Image, Audiovisual, Multimedia, Glossary links, and Card links tabs are indispensable. 
You can search for items by keyword, period, date, or theme, depending on which tab 
is active.
 

To perform a search, enter the search criteria in the different boxes:

Keywords 

- Enter the keyword of your choice by typing it in the search box

- Enter multiple keywords, separated by the expression ‹AND›

- Select a keyword from the drop-down list by clicking on the arrow at the right of 
the search box

You can also enter special keywords:

- The unique card, note or link codes (fd, fi, pt, etc.) display items corresponding to 
a specific code (for example, if you would like to know which introductory notes 
include specific media cards, which chronology cards include specific timeline 
events, or which cards are associated with a specific card link). Enter the code in 
the keyword search box of the relevant page to display a list of all items 
corresponding to that code.

- The keyword *visible (lower case or capitals, singular or plural) displays the list of 
visible cards, those for which you did not check the invisible? box in the edit 
window.

- The keyword *invisible (lower case or capitals, singular or plural) displays the list 
of invisible cards, those for which you did check the invisible? box in the edit 
window.

*Note: The *visible and *invisible keywords apply only to cards, not to other types of 
items.
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Pe r iods

- Enter the name of a historical period included in the archive by typing it in the 
search box

- Enter multiple periods, separated by the expression ‹AND›

- Select a period from the drop-down list by clicking on the arrow at the right of 
the search box

Date

- Enter a single date in the first or second search box

- Enter a date in each search box to create an interval

Themes

- Enter the name of a theme included in the archive by typing it in the search box

- Enter multiple themes, separated by the expression ‹AND›

- Select a theme from the drop-down list by clicking on the arrow at the right of 
the search box

Once you have entered all your search criteria, click on the magnifying glass. A popup 
menu prompts you to choose between:

- Search all fields
- Search specific fields
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The Search results table displays the number of cards found that correspond to the 
criteria you entered, followed by a list of all the cards. Clicking on the title of each 
column will sort the entries in either ascending or descending order, with the 
exception of the Type column. Clicking on the title of the Type column displays a 
drop-down list of all the card types and subtypes. You can select a subtype from this 
list to refine your search to a specific type of card. 

To reset the search criteria and display the default list of all the cards in the archive, 
click on the reset button (icon resembling two circular arrows).
  
*Note: Your search criteria are saved when navigating between tabs, but not between 
pages.
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CHECKING THE ARCHIVE

When you have completed your work, the Check the archive command in the File menu 
allows you to verify the content of your archive by providing a list of cards, notes and 
links that are missing data. 

In the window, check the boxes of all the items you wish to verify.

When you click on OK, the archive is verified and a text file with the name of the 
archive plus the file extension .txt is created on your desktop (My-Archive.txt, for 
example). This file contains a list of all incomplete items among those you chose to 
verify. The file may be opened using any word processing software.
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